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Immunogenicity Assays on the Octet Platform
OVERVIEW

INTENDED USE

Immunogenicity testing, the measurement of an immune response
to a therapeutic drug, is an integral part of drug development. The
immune system may respond to drug administration in patients by
producing anti-drug antibodies (ADA). ADA can alter the pharmacodynamics and/or the pharmacokinetics of the drug, so detecting them
is essential during the development process. ADA can be produced in
a wide range of concentrations and with a wide range of affinities. To
accurately detect these polyclonal antibodies, the system must have
exquisite sensitivity, withstand a wide range of free drug concentrations, and have minimal matrix effects. Automated immunoassays
on Pall ForteBio’s Octet instruments provide a high level of sensitivity,
tolerance to drug, and flexibility to detect both high and low affinity
ADA by providing multiple protocols without any plate washing steps.
These protocols work across the many drug types in the market today
such as antibodies, proteins, and peptides and can be used with both
human and animal samples.

Pall ForteBio Immunogenicity assays enable the detection of ADA
as a part of an immune response to a protein or antibody therapeutic. This technical note describes protocols, biosensors and
basic reagents required to run two different assay configurations:
an enzyme-linked bridging assay and a direct binding assay. The
assays are intended for use with human, primate and other animal
serum and plasma samples.

PRINCIPLE
BLI biosensors are fiber optic tips coated with specific ligand chemistries that enable detection, quantification, and kinetic analysis of
a biomolecular target. The binding of the targeted molecule alters
the interference pattern of light reflected from the biosensor tip to
a detector, allowing molecular association and dissociation events
to be measured in real time with the Octet instrument. Higher
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FIGURE 1: Schematic of the enzyme-linked bridging assay.

FIGURE 2: Schematic of the direct binding assay.
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Tips for Optimal Performance

target concentrations result in both faster binding rates and larger
signal amplitudes. Signal amplification can be achieved on BLI biosensors using multiple molecular layers and addition of enzymecatalyzed substrate precipitation step (Figure 1).

• A cut point analysis is strongly recommended to establish a ~5%
false positive (FP) rate for each sample matrix type.1,2
• Fully equilibrate all reagents and samples to room temperature
prior to preparation. For frozen samples, thaw and mix thoroughly prior to use.

In the case of the enzyme-linked bridging assay, a Streptavidin
(SAX) Biosensor is used to rapidly capture the biotin-drug/ADA/
fluorescein-drug complex out of the treated sample mixture
(Figure 1). By using a standard HRP-linked antibody and precipitating substrate, the Octet instrument’s Biolayer Interferometry
(BLI) technology provides a rapid, sensitive and precise readout.
Using the enzyme-linked assay a 96-well plate can be read in as
little as 30 minutes using the Octet QK384/RED384/HTX system.
Often, this protocol provides enhanced sensitivity compared to
the direct binding protocol.

• Biosensors should be hydrated in Immunogenicity Reagent for at
least 15 minutes prior to use.
• A minimum volume of 200 μL/well in a 96-well microplate (80 μL/
well in a 384-well microplate) is required for the diluted samples,
reagents and the biosensor hydration solution.
• Turn on the Octet instrument at least 40 minutes prior to starting
the assay, to allow the lamp to warm up.
• Set the sample plate temperature in the Octet software by selecting File > Experiment > Set plate temperature, then entering
the desired temperature. Pall ForteBio recommends 30 °C for
immunogenicity assays.

In some cases, a direct binding assay may be more appropriate,
particularly when detecting low-affinity ADA. In this assay the
biotin-drug is immobilized onto the streptavidin biosensor surface
and the ADA is captured and detected directly out of the diluted
sample (Figure 2). A 96-well plate can be read as little as 60 minutes
if the biotin-drug immobilization and blocking steps are performed
off-line.

Protocol Overview
1 Prepare the reagents, including conjugation of biotin and
fluorescein tag to the drug. Reagents can be prepared ahead of
time and stored for future experiments.

PROTOCOL 1: ENZYME-LINKED BRIDGING ASSAY

2 Prepare the assay plate by combining samples, biotin-drug and
fluorescein-drug in Immunogenicity Reagent. Incubate 1–3
hours in the microplate on a shaker at room temperature. Add
detection reagents to the assay plate (or use a separate reagent
plate if using an Octet QK384/RED384/HTX system).

Materials Required
• Octet system with software version 6.1 or later
• Samples to be analyzed (including positive and negative controls), 100 µL per test

3 Run the experiment: transfer the microplate(s) into the Octet
instrument. Hydrate the biosensors and equilibrate the
sample plate for 15 minutes on the Octet instrument before
starting the assay run. Total time for a full 96-well plate =
1 hour for Octet QKe/RED96 systems; 30 minutes for Octet
QK384/RED384/HTX systems.

• Purified drug for immobilization and detection: 1 mg needed for
biotinylation and fluorescein labeling; 4 µg used per test
• High Precision Streptavidin (SAX) Biosensors
(Pall ForteBio Part No. 18-5117)
• Immunogenicity Reagent (See Appendix for recipe)
• Sample Diluent (Pall ForteBio Part No. 18-1048)

4 Perform data analysis and save the results.

• Phosphate Buffered Saline (PBS)
• 96-well microplates (Greiner Bio-One, Part No. 655209)

Prepare Reagents

• Optional 384-well microplates for Octet QK384/RED384/HTX
systems (Greiner Bio-One, Part No. 781209)

1 Equilibrate reagents to room temperature prior to preparation
and mix thoroughly.

• EZ-Link NHS-LC-LC-Biotin (Thermo, Part No. 21343)

2 Biotinylated drug. The drug must be minimally biotinylated to
enable capturing the bridging complex from solution by the
Streptavidin biosensors.

• DMF (Thermo, Part No. 20672)
• PD-10 desalting column (GE Healthcare, Part No. 17-0851-01)
• NHS-Fluorescein (Thermo, Part No. 46410)

A Prepare NHS-LC-LC-Biotin in DMF. Determine the concentration of biotin reagent needed in order to insure the volume
of DMF does not exceed 3% of protein drug solution to be
biotinlyated.

• Stable Peroxide Substrate Buffer (Thermo, Part No. 1855910)
• DAB/Metal Concentrate (10X) (Thermo, Part No. 1856090)
• Rabbit anti-FITC:HRP (AbDSerotec, Part No. 4510-7864)

NOTE: NHS compounds are easily hydrolyzed in aqueous solutions higher
than pH 7. Prepare this solution immediately prior to use. Vortex the solution until all the solids are completely dissolved.
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B Prepare solution of drug to be biotinylated in PBS (the recommended volume and concentration are 0.5 mL or more at
1 mg/mL). If a lower concentration or smaller volume is used
then purification by dialysis instead of by a PD-10 column
may be necessary.

mL of fluorescein reagent =
mg drug
drug MW (mg/mmol)

drug MW (mg/mmol)

mg/mL Fluorescein-NHS in DMF

E Remove the excess Fluor-LC-LC-NHS using PD-10 columns
according to the manufacturer’s instructions, except elute
and collect only 3 mL instead of the 3.3 mL recommended
by the manufacturer, to ensure minimal contamination by
free fluorescein.

mL of biotin reagent =
x MCR x

Fluorescein-NHS MW

D Add the calculated volume of fluorescein reagent to sample.
Incubate 1 hour at room temperature (20–25 °C), protected
from light. During incubation prepare PD-10 columns for
buffer exchange with PBS according to the manufacturer’s
instructions.

C A molar coupling ratio (MCR) of 1 is recommended (1 EZLink NHS-LC-LC-Biotin molecule for every 1 drug molecule),
but can be optimized for each drug molecule. Calculate the
volume of biotin solution to add to the aliquot of drug to
give a solution with an MCR = 1.

mg drug

x MCR x

Biotin-NHS MW
mg/mL Biotin-NHS in DMF

D Add the calculated volume of biotin reagent to sample.
Incubate 1 hour at room temperature (20–25 °C). During
incubation prepare PD-10 columns for buffer exchange with
PBS according to the manufacturer’s instructions.

F Calculate the concentration of labeled drug assuming a
90% yield:
[fluorescein-drug (mg/mL)] = (mg of drug/3 mL) X 90%

E Remove the excess Biotin-LC-LC-NHS using PD-10 columns
according to the manufacturer’s instructions, except elute
and collect only 3 mL instead of the 3.3 mL recommended
by the manufacturer, to ensure minimal contamination by
free biotin.

Prepare Assay Plate
Equilibrate samples, reagents and buffers to room temperature and
mix thoroughly prior to use. When filling the microplates, a minimum of 200 µL should be put in each well of a 96-well microplate
(all instruments), and a minimum of 80 µL in each well of a 384-well
microplate (Octet RED384, QK384 and HTX systems only).

F Calculate the concentration of biotinylated drug assuming a
90% yield:

1 Prepare a solution containing 20 µg/mL biotin-drug + 20 µg/mL
Fluorescein-drug in Immunogenicity Reagent.

[biotin-drug (mg/mL)] = (mg of drug/3 mL) X 90%

2 In a black 96-well microplate:

3 Fluorescein-tagged drug. An aliquot of the drug must be
conjugated to fluorescein to serve as a tag to bridge to the
enzyme-linked detection. This can be performed concurrently
with the biotinylation protocol.

A Combine 100 µL of sample to be tested + 100 µL of the
biotin-drug/fluorescein-drug mixture to generate 200 µL of
diluted sample. Samples should be diluted a minimum of 1:1
in the final mixture. Keep dilution consistent for all samples
to be test.

A Prepare a solution of NHS-Fluorescein in DMF. Determine
the concentration of fluorescein reagent needed in order to
insure the volume of DMF does not exceed 3% of protein
drug solution.

B Repeat for all samples to be tested, filling the plate in columns starting at A1–H1 then progressing to A2–H2, etc.

NOTE: NHS compounds are easily hydrolyzed if exposed to air in aqueous
solutions higher than pH 7. Prepare this solution immediately prior to use.
Vortex the solution until all solids are completely dissolved.

C For reference samples, treat negative control serum and positive spike controls identically to samples as described above.

B Prepare solution of drug to be labeled in PBS (recommended volume is 0.5 mL or greater at 1mg/mL). If lower concentration or less volume is used then purification by dialysis
instead of by PD10 may be necessary.

NOTE: the maximum number of samples that can be run in a 96-well plate
is 64 on the Octet QKe or RED96 systems (see Figure 3) and 96 on the Octet
QK384, RED384 or HTX systems.

3 Cover and incubate the microplate on a plate shaker (> 500 rpm
< 1000 rpm) for 1–3 hours at room temperature (time may need
to be further optimized depending on the shaker) taking care
not to splash the samples out of the wells. Incubation time can
be reduced if plate shaker is at 30 °C. If no shaker is available,
incubate for 4 hours at room temperature.

C A molar coupling ratio (MCR) of 15 is recommended (15
fluorescein-NHS molecules for every 1 drug molecule), but
can be optimized for each drug molecule. Calculate the
volume of fluorescein reagent solution to add to the aliquot
of drug to give a solution with an MCR = 15.
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6 Hydrate the biosensors in Immunogencity Reagent for a minimum of 15 minutes prior to the first measurement. In a 96-well
microplate, pipet 200 μL Immunogenicity Reagent into each well
corresponding to the locations of the biosensors to be used. One
biosensor is needed for each sample to be assayed.

12

A
B
C

7 Place the hydrated biosensors and sample/reagent plates in the
Octet instrument. Make certain the A1 position on the plate is
at the back right corner of the plate holder. Ensure that both the
biosensor tray and sample plate are securely in place and sit flat
on the holder. Equilibrate the samples to the assay temperature
(30 °C) for at least 15 minutes prior to the first measurement.

D
E
F
G
H

Incubated samples
Sample Diluent

Run Experiment

Anti-FITC:HRP
Peroxide Substrate Buffer
Metal/DAB

1 Ensure the Octet instrument and associated computer are
turned on. It is critical that the lamp is warmed up for at least
40 minutes prior to the first measurement.

FIGURE 3: Sample 96-well plate map for use in Octet QK/RED systems.

2 Start the Data Acquisition software (version 6.1 or later).
3 From the Experiment Wizard (ctrl+N) choose the Advanced
Quantitation option.

4 During sample incubation, make certain that all HRP reagents,
buffers and substrates are equilibrated to room temperature.
During the last 10 minutes of the incubation prepare the following solutions:

4 In Tab 1:
A Click the Modify button and choose the Immunogenicity Enzyme-Linked assay file from the list on the left. The settings
in this list are default settings. To modify the settings use the
up/down arrows. Modifications only apply to the current assay
and are saved as part of the assay’s method file. To create a new
assay file, see Help > User Guide > Edit Assay Parameters.

For Octet QKe/RED96 systems – 96-well plate only
• 2 mL anti-FITC:HRP antibody conjugate diluted 1:1000 in
Sample Diluent (ProClin®300).
• 2 mL Metal/DAB substrate diluted 1:10 in Peroxide Substrate Buffer.

B Right-click on the plate map and define locations for reagents, samples, standards and references.

For Octet QK384/RED384/HTX systems – 96-well plate only
• 4 mL anti-FITC:HRP antibody conjugate diluted 1:1000 in
Sample Diluent (ProClin®300).

C Enter Sample ID, concentrations and dilution factors as appropriate into the table.

• 4 mL Metal/DAB substrate diluted 1:10 in Peroxide Substrate Buffer.

5 In Tab 2:
A Define the locations of the biosensors. Default locations are
shown automatically and can be changed by highlighting the
biosensors and using the Remove, Fill or Fill Plate buttons.

For Octet QK384/RED384/HTX systems – 384-well plate only
• 2 mL anti-FITC:HRP antibody conjugate diluted 1:1000 in
Sample Diluent (ProClin®300).

B Choose Streptavidin from the Sensor Type drop-down
menu. Add biosensor Information in the table on the right,
if desired.

• 2 mL Metal/DAB substrate diluted 1:10 in Peroxide Substrate Buffer.
5 After the sample incubation is complete, remove the plate from
the shaker and add reagents in each well as necessary. Array
the reagents in columns (single columns for the 8 channel
Octet QKe and Octet RED96 systems, duplicate columns for the
Octet QK384/RED384/HTX systems). Reagents can be placed in
any column. Figure 3 depicts a plate set up to be used with the
Octet RED96 system, having reagents in columns 9–12.

6 In Tab 3:
A Enter the location and folder name in which the data should
be saved.
B Enter a delay if needed to complete the 15 minute minimum
sample equilibration and biosensor hydration time.
7 Click the GO button to start the assay. The default settings ensure
the data, method and runtime charts are saved automatically.

NOTE: when using Octet QK384/RED384/HTX systems, reagents must be arrayed
to accommodate the 16 channel layout (See the User Guide for a complete
description of working in 16-channel mode).
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FIGURE 4: Typical concentration response curve for detecting ADA (sheep
anti-goat IgG) in the presence of 10 µg/mL of drug (HIgG) in the sample (data
taken on the Octet RED system at 1000 rpm).

FIGURE 5: In this example, the bridging assay format can tolerate > 500-fold
molar excess of drug in these samples.

[ADA],
(ng/mL)

Run 1

Run 2

Run 3

Mean

SD

CV%

[Drug]
(µg/mL)

[free ADA]
(ng/mL)

Run 1

Run 2

Run 3

Mean

SD

CV%

250

5.936

4,572

5,361

5,290

0,685

12.9

50

2000

2.020

2.275

2.245

2.180

0.139

6.4

100

1.667

1.630

1.524

1.607

0.074

4.6

1000

1.023

1.020

0.999

1.014

0.014

1.3

50

0.775

0.743

0.712

0.744

0.031

4.2

500

0.518

0.493

0.509

0.507

0.013

2.5

25

0.508

0.437

0.439

0.461

0.040

8.8

200

0.275

0.265

0.262

0.267

0.006

2.4

10

0.271

0.259

0.257

0.262

0.008

2.9

100

0.174

0.188

0.167

0.176

0.011

6.0

5

0.251

0.231

0.225

0.235

0.014

5.8

0

0.117

0.114

0.106

0.112

0.006

5.0

0

0.162

0.158

0.156

0.165

0013

7.8

0

0

0.118

0.120

0.115

0.111

0.009

7.9

0

0.173

0.188

0.154

0.172

0.017

9.8

0

0

0.101

0.099

0.110

0.103

0.006

5.6

TABLE 1: Typical binding rates for a titration of an ADA (no drug present).

TABLE 2: Example binding rates for an ADA in the presence of 50 µg/mL of drug.

Analyze Data

B Select R equilibrium as the binding rate equation. This
equation will fit the binding curve generated during the
experiment and calculate a response at equilibrium as the
output signal.

1 Start the Data Analysis software (version 6.1 or later).
2 In Tab 1:
A Load data by locating the data folder in the explorer, rightclicking it, then choosing Load Folder from the pop-up menu.

C Click Calculate Binding Rate. Results will be displayed automatically in the table.

B Select data to analyze by clicking on the data folder in the
Quantitation pane at the top of the window. Multiple data
sets can be selected for analysis. All selected data sets will
be analyzed as a group.

D Click the Save Report button or select File> Save Report to
generate a Microsoft® Excel formatted report.

Representative Data

C Once the data is loaded, sample ID, group, concentration
and dilution factors can be modified in the table if needed.

Figure 4 and Table 1 show data from assays set up on the Octet
RED96 system according to the enzyme-linked bridging assay protocol. The binding curves shown in Figure 4 are typical
response curves for detecting ADA in the presence of drug. The
data shown in Table 1 are for three independent assays run with
an identical setup and assay protocol. Data show clear detection
of 5 ng/mL ADA (sheep anti-human polyclonal antibody) over 3
standard deviations above background.

3 In Tab 2:
A Select the desired standard curve (optional). If no standards
were included in the experiment, then the output will be
binding rates only.
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• A minimum volume of 200 μL/well in a 96-well microplate
(80 μL/well in a 384-well microplate) is required for the diluted
samples, reagents and the biosensor hydration solution.

Table 2 and Figure 5 contain example binding rates for an ADA
in the presence of 50 µg/mL of drug (polyclonal human IgG).
Binding rates shown were calculated from data run on the Octet
RED system using the enzyme-linked bridging assay protocol described above. The signal of the 100 ng mL ADA in the presence
of 50 µg/mL drug is 3 standard deviations over background. This
data shows a tolerance of at least 500-fold higher concentration
of drug over ADA.

• Turn on the Octet instrument at least 40 minutes prior to starting
the assay, to allow the lamp to warm up.
• Set the sample plate temperature in the Octet software by selecting File > Experiment > Set plate temperature, then entering the
desired temperature. Pall ForteBio recommends 30 °C for the
immunogenicity assay.

PROTOCOL 2: DIRECT BINDING ASSAY

Protocol Overview

Materials Required

1 Prepare the reagents, including biotinylating the drug. Reagents can be prepared ahead of time and stored for future
experiments. Total time = 1.5 hours

• Octet system with software version 6.1 or later
• Samples to be analyzed (including negative and positive controls), 40 µL per test

2 Load Streptavidin biosensors with biotin-drug. This process can
be performed in batch mode and the biosensors preserved for
future use. See Technical Note 10: Batch Immobilization of a Biotinylated Ligand onto Streptavidin Biosensors for complete details
on optimizing the immobilization.

• Negative pool serum, for blocking the immobilized biosensors.
• Purified drug for immobilization: 0.5 mg needed for biotinylation;
10 µg used per test
• High Precision Streptavidin (SAX) Biosensors
(Pall ForteBio Part No. 18-5117)

3 Block the immobilized biosensors in a matrix similar to that
used for the samples.

• Immunogenicity Reagent (See Appendix for recipe)
• Sample Diluent (Pall ForteBio Part No. 18-1048)

4 Prepare the assay plate by pipetting samples, controls and references into a microplate. Total time = 15 minutes

• Phosphate Buffered Saline (PBS)
• 96-well microplates (Greiner Bio-One, Part No. 655209)

5 Run the experiment: transfer the microplate(s) into the Octet
instrument. Hydrate the biosensors and equilibrate the sample
plate for 5 minutes on the Octet instrument before starting the
assay run.

• Optional 384-well microplates for Octet QK384/RED384/HTX
systems (Greiner Bio-One, Part No. 781209)
• EZ-Link NHS-LC-LC-Biotin (Thermo, Part No. 21343)
• DMF to dissolve biotin and Fluorescein-NHS
(Thermo, Part No. 20672)

6 Analyze the data and save the results.

• PD-10 desalting column (GE Healthcare, Part No. 17-0851-01)

Prepare Reagents

• Sucrose (Sigma, Part No. S0389); prepare as a 15% (w/v) solution
in distilled deionized water

1 Equilibrate reagents to room temperature prior to preparation
and mix thoroughly.

• Pall ForteBio Technical Note 10: Batch Immobilization of a Biotinylated Ligand onto Streptavidin Biosensors

2 Biotinylated drug. The drug must be minimally biotinylated to
enable immobilization to the Streptavidin Biosensor.
A Prepare NHS-LC-LC-Biotin in DMF. Determine the concentration of biotin reagent needed in order to insure the volume
of DMF does not exceed 3% of protein drug solution to be
biotinlyated.

Tips for Optimal Performance
• A cut point analysis is strongly recommended to establish approximately a 5% false positive (FP) rate with each sample matrix
type.1,2

NOTE: NHS compounds are easily hydrolyzed in aqueous solutions higher
than pH 7. Prepare this solution immediately prior to use. Vortex the solution until all the solids are completely dissolved.

• Equilibrate reagents and samples to room temperature prior to
preparation. For frozen samples, thaw and mix thoroughly prior
to use.

B Prepare solution of drug to be biotinylated in PBS (the recommended volume and concentration are 0.5 mL or more at
1 mg/mL). If a lower concentration or smaller volume is used
then purification by dialysis instead of by a PD-10 column
may be necessary.

• Biosensors must be hydrated for at least 5 minutes before use.
• Blocking the immobilized biosensors with a matrix similar to
that used for the samples will improve assay sensitivity. Block the
biosensors for at least one hour.
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6 The next day prepare 2 plates containing Sample Diluent and one
plate containing 15% sucrose (w/v in distilled, deionized water).
Each plate should contain 200 µL of the appropriate solution in the
wells corresponding to the locations of the biosensors.

C A molar coupling ratio (MCR) of 1 is recommended (1 EZLink NHS-LC-LC-Biotin molecule for every 1 drug molecule),
but can be optimized for each drug molecule. Calculate the
volume of biotin solution to add to the aliquot of drug to
give a solution with an MCR = 1.

7 Remove the biotin-drug plate from the biosensor tray bottom
and replace with a plate containing Sample Diluent. Incubate
the biosensors in the Sample Diluent 2–5 minutes. Replace the
first Sample Diluent plate with the second one and incubate
again for 2–5 minutes for a total of 2 washes.

mL of biotin reagent =
mg drug
drug MW (mg/mmol)

x MCR x

Biotin-NHS MW
mg/mL Biotin-NHS in DMF

8 Preserve the biosensors by replacing the plate containing Sample Diluent with the plate containing 15% sucrose. Incubate
the biosensors in the sucrose 2–5 minutes. Remove the sucrose
plate and allow the biosensors to dry. Store coated biosensors
in the original re-sealable bag. Biosensors must be rehydrated
prior to use.

D Add the calculated volume of biotin reagent to sample.
Incubate 1 hour at room temperature (20–25 °C). During
incubation prepare PD-10 columns for buffer exchange with
PBS according to the manufacturer’s instructions.
E Remove the excess Biotin-LC-LC-NHS using PD-10 columns
according to the manufacturer’s instructions, except elute
and collect only 3 mL instead of the 3.3 mL recommended
by the manufacturer, to ensure minimal contamination by
free biotin.

Block Biosensors and Prepare Assay Plate
Equilibrate all samples and buffers to room temperature and mix
thoroughly prior to use. When filling microplates, use a minimum
of 200 μL/well in a 96-well microplate (all instruments), and a minimum of 80 μL/well in a 384-well microplate (Octet QK384/RED384/
HTX systems only).

F Calculate the concentration of biotinylated drug assuming a
90% yield:
[biotin-drug (mg/mL)] = (mg of drug/3 mL) X 90%

1 Prepare the blocking solution for the biosensors. Blocking
solution should be a matrix as similar to the samples as possible
(typically 20% serum in Immunogenicity Reagent). 200 µL of
blocking solution is needed per biosensor.

Load the Biosensors
The biotinylated drug can be immobilized onto the Streptavidin
biosensors in batch mode. Using a batch mode approach allows
the biosensors to be prepared in advance and stored for later use.
A general outline for a batch-loading procedure is given below. This
procedure may need optimization depending on the biotinylated
molecule used.

A Pipet 200 µL of the blocking solution into wells in a 96W
microplate that correspond to the number and position of
biosensors to be treated.
B Place the plate with the blocking solution into the lower
portion of the biosensor tray. Carefully lower the biosensors
into the liquid by lowering the top portion of the tray into
the bottom portion. Allow to block for at least 1 hour.

NOTE: For complete details on how to develop and validate batch loading procedures, see Pall ForteBio Technical Note 10: Batch Immobilization of a Biotinylated
Ligand onto Streptavidin Biosensors.

1 Prepare a 50 µg/mL solution of biotin-drug in Sample Diluent
(~20 mL are needed to load 96 biosensors simultaneously).

2 While the biosensors are in the blocking solution:

2 In a 96-well microplate, pipet 200 µL of the biotin-drug solution
into each of the wells corresponding to the locations of the biosensors to be used.

A Dilute samples a minimum of 1:5 in Immunogenicity Reagent to give a final serum concentration of 20% (use the
same dilution for samples and blocking solution).

3 In a second 96-well microplate, pipet 200 µL of Sample Diluent
into each of the wells corresponding to the locations of the biosensors to be used.

B If a reference sample is desired, treat negative control serum
identically to the sample.
C Pipet the diluted samples and references into the appropriate wells filling the plate in columns starting at A1–H1 then
progressing to A2–H2, etc.

4 Place the plate containing Sample Diluent in the lower portion
of a biosensor tray. Carefully lower the biosensors into the
liquid by lowering the top portion of the tray into the bottom
portion. Allow to hydrate 5 minutes.

NOTE: when using QK384/RED384/HTX systems, reagents must be arrayed
to accommodate the 16 channel layout (See the User Guide for a complete
description of working in 16-channel mode).

5 Remove the plate with the Sample Diluent and replace with the
plate containing biotin-drug. Lower the biosensors into solution. Incubate overnight (8–16 hours) at 4 °C.
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3 Place the blocked biosensors and sample plates in the Octet
instrument with the A1 position on each plate toward the back
right corner of the plate holder. Ensure that both the biosensor
tray and sample plate are securely in place and sit flat on the
holder. Equilibrate the samples to the assay temperature (30°C)
for a minimum of 5 minutes prior to the first measurement.

ADA
Concentration

1.20

10 µg/mL
2 µg/mL
1 µg/mL
0.5 µg/mL
0.25 µg/mL
0.1 µg/mL

1.00

Run Experiment

0.80

nm

1 Ensure the Octet instrument and associated computer are
turned on. It is critical that the lamp is warmed up for at least 40
minutes prior to the first measurement.

0 µg/mL
0 µg/mL

0.60

2 Start the Data Acquisition software (version 6.1 or later).

0.40

3 From the Experiment Wizard (ctrl+N) choose the Basic Quantitation option.

0.20

4 In Tab 1:

0.00

0

30

60

90

120

150

180

210

240

270

300

Time (sec)

A Click the Modify button and choose the Immunogenicity Direct assay file from the list on the left. The settings in this list
are default settings. To modify the settings use the up/down
arrows. Modifications only apply to the current assay and are
saved as a part of the assay’s method file. To create a new assay
file, see Help > User Guide > Edit Assay Parameters.

FIGURE 6: Typical ADA (polyclonal sheep anti-human antibody) binding
curves obtained using the direct binding assay in the absence of drug.

ADA Concentration

0.28

B Right-click on the plate map and define locations for
samples, standards and references.

10 µg/mL
2 µg/mL
1 µg/mL
0.5 µg/mL
0.25 µg/mL
0.1 µg/mL

0.24

C Enter Sample ID, concentrations and dilution factors as appropriate into the table.

0.20

nm

5 In Tab 2:
A Define the locations of the biosensors. Default locations
are shown automatically. Locations can be changed by
highlighting the biosensors and using the Remove, Fill or Fill
Plate buttons.

0 µg/mL
0 µg/mL

0.16

0.12

0.08

0.04

B Choose Custom from the Sensor Type drop-down menu. Add
biosensor Information in the table on the right, if desired.

0.00
0

6 In Tab 3:

100

200
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A Enter the location and folder name in which the data should
be saved.

FIGURE 7: Typical ADA binding curves using the direct binding assay
format in the presence of 20 µg/mL of drug (polyclonal human IgG).

B Enter a delay if needed to complete the 5 minute minimum
sample equilibration and biosensor hydration time.
B Select data to analyze by clicking on the data folder in the
Quantitation pane at the top of the window. Multiple data
sets can be selected for analysis. All selected data sets will
be analyzed as a group.

7 Click the GO button to start the assay. The default settings ensure
the data, method and runtime charts are saved automatically.

Analyze Data
1 Start the Data Analysis software (version 6.1 or later).

C Once the data is loaded, sample ID, group, concentration
and dilution factors can be modified in the table if needed.

2 In Tab 1:
A Load data by locating the data folder in the explorer, rightclicking it, then choosing Load Folder from the pop-up menu.
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3 In Tab 2:
A Select the desired standard curve (optional). If no standards
were included in the experiment, then the output will be
binding rates only.
B Select Initial Slope as the binding rate equation. This equation
fits the binding curve generated during the experiment and
calculates a response at equilibrium as the output signal.
C Click Calculate Binding Rate. Results will be displayed automatically in the table.
D Click the Save Report button or select File> Save Report to
generate a Microsoft® Excel formatted report.

1 Mire-Sluis, A.R. et al. Journal of Immunological Methods, 2004,
289, 1–16.
2 Shankar, G. et al. Journal of Pharmaceutical and Biomedical
Analysis, 2008, 48, 1267–1281.

APPENDIX
Immunogenicity Reagent recipe:
• 10mM PBS, pH 7.4
• Tween®-20, 0.02%
• Bovine Serum Albumin (≥ 98% purity), 0.10% W/V
• Sodium Hydroxide (2N), 1.80% V/V

Representative Data
Figure 6 shows typical ADA binding curves obtained using the
direct binding assay in the absence of drug.

• Acetic Acid, 7.50%

Figure 7 shows typical ADA binding curves in the presence of
20 µg/mL of antibody drug in the sample.
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